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Launch Pad 

The LaunchPad is your personal central “hub” to access everything you need on Glow. Use it to 

access your personal apps that you use, or websites you visit often, or to see areas that your school, 

Local Education Authority, or Glow Scotland think you may find interesting. 

Add A Tile 

 Click the tile with ADD (only available on your own Launchpad, not the School, LEA, or 

Scotland ones) 

 Choose Personal Tile (to add an external website URL), or App From Library (to add a Glow 

App) 

o Personal Tile 

 Fill in the Title and URL (web address – copy/paste from original website) 

 Click the Generate Thumbnail button for Glow to use an image from the site 

 Click OK – Tile is added to the LaunchPad 

o App From Library 

 Search for the tile you want, either using the categories down the left, or 

through the pages of tiles, or via the search box at the top 

 Click “Add To LaunchPad” 

 Close the tile’s description window – Tile has been added to the launchpad 

Edit Tiles 

 On the Launchpad, click the Edit Tiles icon (only available on your own Launchpad)

 
 Tiles now have a number and a delete cross added. Use the number to re-order, and the 

cross to delete 

 Changes are made when you click Save Changes 

Download Office 

 Click Add A Tile – App From Library 

 Search for Office 

 Find the tile with Download Office Now (it’s Orange so easy to spot), and add it 

 Add that tile to your launchpad 

 On the device/computer you want to add Office 365 to, click that tile 

 Click the INSTALL button at the bottom, and Office 365 will be installed on that 

computer/device. You can have up to 5 installations as part of your Glow subscription. 

Glow Mail 

Glow Mail is you email app, but you can use it for a lot more than just email. 
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Settings 

 Click the Cog icon, located at the top right, near your account picture -  

 This is where you can access the various settings about how your email app looks and works. 

There are a lot to choose from, but the ones to be aware of are: 

o Themes – Change how your program looks, colour schemes, background images etc. 

o Display Settings – Decide where the reading pane is shown, if at all. Also lets you 

decide what happens when you delete something, and what you see when you first 

open the app. 

o Automatic Replies – lets you set “Out Of Office” replies, to people that email you 

from within Glow or a different one for people that email you from outside of Glow 

Folders 

Folders allow you to organise your email inbox, so that your email messages are easy to find and 

respond to, if required. 

 In the Left Column, Hover over the word FOLDERS, and a plus sign will appear.

 
o OR, you can right-click on the word FOLDERS, and choose Add Public Folder To 

Favourites 

 Name the folder that is created (e.g. SMT) 

Now that we have a folder created, we can move messages to that folder either manually or 

automatically. 

 Manually 

o Right-click on a message you want to move 

o From the list that appears, choose MOVE 

o Your list of folders appears. Choose the folders you want to move that message to. 

o If the folder isn’t on the list, at the bottom, choose Move To A Different Folder 

 Automatically 

o Right-click on a  message from the person whose emails you always want to move to 

the folder 

o Choose Create Rule… - this open the New Inbox Rule window. 

o Complete the window with your requirements. Name of the rule, conditions that 

must be met, actions to take once those conditions are met, and any exceptions. 

Don’t forget that you can remove any conditions as well as add them 

o Click OK at the top 

o Your new rule has been created, and will be applied to any further messages you 

receive from that person. 
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Contacts 

For effective use of email, you should have a list of contacts – people that you email regularly should 

be included, rather than having to search for them every time you want to email them. You can add 

people to your contacts from the email app itself, or from the contacts list. 

 At the bottom of the left-hand column, click the People button  

o This will open your contacts list. 

 In the SEARCH PEOPLE box at the top of the left column, add the name of the person you are 

searching for. 

o You may get a number of people with the same name. Remember that Glow is now 

searching everyone within education in Scotland, so if you are looking for someone 

with a common name, it will bring up a lot of results. You can narrow the results 

down by: 

 Searching for Mr, Miss or Mrs, rather than the full name. This will only find 

teachers 

 If you know the persons glow address, search for that instead 

 In the resulting list, look for the person you want to find. If you have a lot of results: 

o See if they have added a profile picture (always a good idea), or 

o Look at their email address for their full name, or the school/authority they work 

for. 

 If you are still unsure if you have found the right person, click on their name to open their 

profile. From there you will see their full details, including the school they work for. 

 Once you have the person you want to add, click their name to open their profile, then use 

the ellipses (…), to add them to your contacts.

 
 To Delete a contact, hover your mouse over their name in your contacts list, and click the 

checkbox that appears to the left of their name. 

 At the top of the screen, click Delete. 

 OR, click their name to open their profile on the right of the screen, then click the ellipses, 

and Delete. 
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Calendar 

The Calendar app allows you to add/delete appointments, but also can be used to set up meetings 

(physical or Skype), and can be shared, or added to. 

 To Add an Appointment 

o Double-click on the date you wish to add the appointment to. 

o Complete the required fields. Note that you have the options to: 

 Set the usual date, start/end time, reminder etc 

 Add repetitions, for weekly, daily or monthly events 

 Set a location for the appointment (useful if you are setting up a physical 

meeting, as this will me emailed to the invitees) 

 Add Attendees (required and optional) 

 Add an Email Reminder 

 Make it a SKYPE meeting 

 Add a Charm. This is a small icon that appears on your calendar to indicate 

what the appointment is about 

 Categorise – colour-code your appointments 

You can share a calendar with colleagues – perhaps with your department with details of 

departmental activities, meetings, report dates, etc, or create a calendar for a specific event, 

perhaps an out-of-school trip that various things need to be completed at specific dates/times etc. 

 To share a calendar 

o Click the Share icon at the top of the screen  

o Start typing the name of the person you want to share the calendar with.  

 As you type, the system will search your contacts list first, and then the 

wider Glow community, so it makes sense to have the people you want to 

share it with in your contacts list. 
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Tasks 

Tasks is your powerful to-do list 

 Click the Tasks icon at the bottom of the left-hand column  

o This will open up the Tasks app 

 To add a task, click the New button at the top of the page. 

o Complete the Subject, Due date, and any text reminders required. 

o Click the Show More Details button. 

 This gives you access to a lot more options that you may wish to include, 

such as start/end dates, repetitions, mileages (for events outside of school 

for which travel may be billable), and how long you spent on the task, in 

school and out of school. 

o Click SAVE 

 Your task is added to the list 

 Once a task is completed 

o Select the task on the list, and click Complete from the options at the top 

 The task is now struck through, and removed from the list. 

o To see all tasks, whether completed or not, change the drop-down at the top of the 

list from Active to All  
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Groups 

Groups are collaborative spaces that you can use to work with your colleagues or your pupils. As 

owner of the group, you decide who is included in the group, and you have control over the group 

settings. 

 In the email app, click on Groups in the left hand column 

o This will expand the list of groups you are in 

 You may have been added to groups without your knowledge, perhaps by a 

PT or other staff member, or the group may be a whole-school group. You 

may even have been added by mistake. 

 To remove yourself from a group that you are not the owner of: 

o Click on the group name to open it 

o Click the Cog icon at the top right of the screen to open the group settings 

o Choose Leave Group. Note that you can’t leave the group if you created it, unless 

you promote another user to Owner status. 

 To promote another user to owner 

 Click the number of members at the top right of the screen, which 

will show you a list of members 

 Hover over the person you want to promote, and click the ellipses 

(…) that appear 

 Choose Make Owner  

 To create a group 

o Click the Plus sign (+) beside the word Groups in the left-hand column 

o Choose a type of group (most groups are Standard Groups) 

o Give the group a name and description 

 All groups can be searched for by anyone in Glow, so the best format for the 

group name is LEA-School-Subject-Class (eg EDC-Bearsden-English-S2). That 

way, people know exactly to whom the group refers, rather than calling it a 

more generic name like “English”, which could apply to any year group in 

any school. 

 As you type the name, Glow will tell you if the name you are choosing is 

already being used by another group. All group names need to be unique. 

o Set the privacy setting 

 The contents of Private groups are only visible to group members 

 The content of Public groups can be seen by anyone within Glow 

o Click Create 

 The group is created, but has no members yet 

 To Add Members to a group 

o Click in the box and add their name or email address manually, in the same way as 

you did when adding contacts to your contact list. 

With the group created, you can have email conversations, add files and calendar events, or access a 

one-note files for the group, or even set up a group website via Glow Sites. 
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One Drive 

One Drive is your storage area in “the Cloud”. Every Glow user has 1 Tb (TerraByte) of storage 

available in One Drive, which is 1024 Gb. More than enough for all of your work-related files, photos, 

PowerPoints, Spreadsheets etc. There are no limitations to what types of files you can store, and 

once there, all files and folders can be shared with as many people as you want, both inside and 

outside of Glow. 

Accessing One Drive 

 You can gain access to your OneDrive in a couple of ways: 

o Via a tile on the Launchpad 

o Add a tile from the library to your launchpad. Search for Office, and you will find it 

there 

 Via any other Office app 

o Open any other Office 365 app (eg Mail), and you will see the “App Launcher” which 

looks like a small grid of 9 squares (sometimes called the Waffle).  

o Click the app Launcher, and you will see one Drive listed. 

Uploading files 

Upload pre-existing files from your hard drive to One Drive, thus saving space on the network, and 

making your files accessible from anywhere with an internet connection. 

 Click the Upload button  

 Choose if you are uploading a single file, or a folder of files. 

 Browse to the file or folder, and click Upload 

 You can also “Drag and Drop” files or folders directly from your desktop or a Windows 

Explorer window straight into OneDrive 

Create New Files 

As part of Office 365, OneDrive gives you access to on-line versions of Word, Powerpoint and Excel, 

along with other apps, and you can create files directly in the browser, rather than needing to create 

them offline and upload them. 

 Navigate to the folder in which you want to create the file 

 Click the New button  

 Choose which type of file you want to create 

 An Online version of that program opens up, and you can create the file there. 

o You don’t need to worry about saving the file, as it is saved automatically for you 

o The name of the document is shown at the top of the screen – usually Document1. 

This of course can be renamed, by double-clicking on the name and typing the new 

name. 

 When you have finished, simply return to OneDrive, either by using the Back button on the 

browser, or by closing the tab if it has opened a new one. You will see your new file listed. 
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Collaboration 

One of the great strengths of Glow is it’s collaborative abilities, and OneDrive allows any file to be 

shared amongst as many users as you wish. The file can then be worked on either individually by 

each user, or simultaneously by all users. 

There are a number of ways in which you can share a file or folder. 

 Hover your mouse over the file or folder you want to share. 

o A Share icon appears  

o Click the Share icon 

 

 Select the file or folder you want to share 

o A set of Ellipses (…) appear 

o Click the ellipses, and choose Share 

 

 Right-click on the file or folder you want to share 

o Choose Share from the menu that appears 

 

 Select the file or folder you want to share 

o Click Share on the menu at the top of the screen 

All of these have the same result – the Share window opens. 

 This window is where you decide who to share the file with, 

and how you will share it with them, whether is it by email, 

or with a link displayed on a webpage, or Glow Blog, for 

example. 

 Use the box at the top of the window to change who you will 

share the link with. 

 Using the Ellipses(…) at the top to decide the level of access 

that other users have, whether they can make changes to 

the file, or simply view it without the ability to edit. 
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You can also work collaboratively in real time, with a number of people working on a single file at 

the same time. This could be useful in a classroom situation where you want pupils to work together 

on a Powerpoint or Word document, for example. 

Simply share the file in the same way as above, and when people are working on it, if you have it 

open, you will see each user has a different coloured cursor, and you can see what they are adding 

as they add it. 

At any point, you can click on the file to select it, and choose “Version History” from the menu at the 

top of the screen to see who added what and when. This is useful to see how a file develops over 

time, perhaps as part of a homework project. To see the file at any point in its version history, click 

on the Ellipses and choose Open File. 
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Glow Blogs 

Glow Blogs can be used as a way of informing the world at large about the school, the department, a 

class, or a specific project, such as Sports Day, or a visit to the school by a distinguished guest. You 

can also use them as e-portfolios, allowing the pupils to keep a detailed track of their life inside and 

outside of school, ready to print and offer to prospective employers, FE colleges/Universities, or as a 

transition document from P7 – S1. 

Blogs are accessed via the LaunchPad. 

 On your LaunchPad, click Add, then App from Library 

 Search for Blog 

o You will see that every authority has its own Glow Blogs tile.  

 Select the tile for your authority and add it to your LaunchPad. 

 Once added, click the tile on the launchpad 

You will see the latest posts on selected blogs, and three buttons along the top of the page – Create 

a Blog, MySites and Help. 

Any blogs you create can be accessed via My Sites. 

Help will take you to the Help pages for Glow Blogs. 

To create a Blog: 

 Click on Create a Blog 

o You will see a list of blogs (sites) you already have. 

 In Site Name, give your blog a name 

o You will see the first part of the blog’s address above the box into which you are 

typing – you are adding the last part. 

 Give your blog a title 

o The title is what will appear on the Blog itself, whereas the name you created above 

will be the web address for the blog. 

 Set a Privacy setting 

o Do you want Search Engines to access your site? If it is only to be used for a specific 

purpose, or you are only going to show it to specific people via a link, then NO. If it is 

to be used as the school or Department website, then YES. 

 In Site Type, choose Blog 

 Click Create Site 

Your Blog is created, and a sample post is added. 

 To see how your blog looks, click the name of the blog at the top of the screen, then Visit 

Site. You will see the blog as it’s visitors will see it. 

 To go back to the Dashboard, click the name of the site again at the top 
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You have just created a WordPress Website, and there are literally hundreds of options available to 

you now. They are all accessed via the black menu down the left-hand side of the screen. There are 

far too many to go into in detail here but a few that you should be aware of are: 

Posts – This is where you add posts to your site, or see a list of all posts already added. You can edit, 

delete or categorize posts from here as well. 

Media – this is your library of images, videos and audio that you may want to use in your site, either 

in posts or on static pages. 

Pages – if you want to create a static webpage, rather than a blog post, this is where you can do 

that, as well as viewing all pages in the site. 

Comments – if you have allowed users to add comments on your posts, they can be viewed here. 

You can also decide if they should be moderated before they appear on the site. (See Settings) 

Appearance – this is where you set the overall look of the site, by using THEMES. There will be a few 

included to choose from, and if your authority has allowed it, you can download thousands of others 

to try out. You can also Customize any of the installed themes to suit your particular tastes. 

The Appearance>Menus menu is where you can set the menus for your site, which pages to show, 

where the menus appear and what is on them etc. 

Appearance>Widgets - Widgets are small pieces of code that will do a specific thing, like a login 

button, or an audio player. This area is where you can decide which widgets are used, and where 

they go. 

Plugins – These are special features that you may or may not decide you want on your site. 

Examples could be a calendar of events, or an analytics package to see how your site is being used by 

visitors. Your authority may allow you to install your own, in which case there are thousands to 

choose from. 

Users – all registered users to your blog will have a profile, and this is where they are listed. 

Settings – There are a number of general settings to be aware of, including the option to allow or 

disallow comments on your posts (Discussions section), How many posts appear on a page, and 

whether the blog is Public, Glow Only or Private (Reading section). 

 

E-Portfolios 

E-Portfolios are the same as Blogs, but in the Create process, you should click E-Portfolio rather than 

Blog when asked for the Blog Type. 

The difference is mainly that the posts have a list of categories (Profile Tags) that should be assigned 

to each post, and it is not designed for public consumption, although a pupil can of course show it to 

their teacher, parents etc.  

There should also be an ABOUT page, with general information about the pupil, his/her likes and 

dislike, strengths and abilities.  
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Sway 

Sway can be looked on as a viable alternative to Powerpoint as a means of communicating 

information. It is easy to use, and the user focuses on content, rather than design, as a variety of 

designs can be set with a single click. 

 To open Sway from within an app 

o Open any Office 365 app, eg One Drive or Mail 

 The App Launcher is the small grid of 9 squares at the top left corner of the 

screen. 

o Click the App Launcher 

 Sway is located in the list that appears 

o Click Sway 

 To open Sway from the LaunchPad 

o Add a tile from the App Library 

o Search for Sway 

o Add the Sway tile to your launchpad 

The Sway homepage will show you any Sways you have already created, plus some templates and 

completed Sways that you can use to get started. We will start from scratch and create our own. 

 Click on Create New 

o An empty Sway will open 

Sway uses “Cards” to add the various types of content. The first card that opens is the Title card. 

 Click in the box with Title Your Sway, and add a title 

o You can use the Emphasis, Accent or Link buttons to make the text Bold, Italic or a 

Hyperlink 

 Click the Background box 

o This is how we add an image. On the pane that opens on the right, you can use the 

search box to search for any online images, or use the suggested categories, or you 

can use content stored in your OneDrive or on your hard drive 

 When you find an image you want to use, select it, and click on the ADD button at the top. 

o Or you can “Drag and Drop” the image into the placeholder. 

o Focus Points allow you to ensure that specific parts of an image are always in view, 

no matter what device it is viewed on, or what screen resolution.  

o Click on the Focus Points button, and then click on the important parts of the image 

that appear on the right. That part of the image will always be visible. 
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Click the green Plus sign at the bottom of the Title Card. This will open up a box asking which type of 

card you now want to add. There are 3 categories, plus a Suggested category. This will let you see 

what types of content you can add. The basic techniques are the same as we used for the Title card, 

but there are some things to be aware of: 

Stack – This is a Stack of images that are animated, as if you are flipping through a pile of 

photographs. To use a Stack, click the Stack utton, and then select a number of images. You can 

change the group type, or size of the images using the small toolbar at the top of the window. 

You also have the option of adding a text caption which will be displayed along with the image. 

Video (in the Media category) – This works in the same way as images, in that you can search for 

online content, in this case YouTube videos. A number of suggestions are given initially, but with a 

search box at the top for you to use if you prefer. You can also add a caption, and adjust the size of 

the video.  

Audio (in the Media category) – this gives you the option of adding an audio file from your OneDrive 

or Hard Drive, but you can also record an audio file directly from Sway, using the Microphone 

button. Click the button, and a small window appears at the bottom, allowing you to record your 

audio. If you are happy with it, click the Add To Sway button that appears. 

 

View your Sway 

So far, we have only added content, with no regard for how it looks on screen to the viewer. At any 

point, you can click the PLAY button at the top of the screen to see how your Sway will look when 

displayed. 

When viewing the Sway, you can navigate through it using the Navigation Controls at the bottom 

right corner of the screen.  

Notice that the Sway itself is a continuous “roll”, rather than divided up into different slides like a 

Powerpoint would be. You can adjust the direction of the navigation (Horizontally or Vertically) using 

the Settings button (cog icon).  

Note that a Vertical Sway is navigated using the Arrow keys on the computer keyboard, or the 

scrollbar on the right of the screen. 

At any point, you can return to the edit screen by using the Edit button at the top right menu. 
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Changing the design of your Sway 

With the content in, we can very quickly and easily change how the Sway looks on screen. 

 In Edit mode, click on the Design tab at the top left of the screen 

o This will show you how your Sway looks at the moment. 

 Click the Styles button at the top right 

 Adjust the navigation direction, and the Theme to try out different looks.  

 If you like MOST of a theme but not specific things about it (perhaps the font, or the colours 

used), click the Customise button to make changes. 

 You can also click the REMIX! Button to try a completely different theme in a single click. 

Once your Sway is finished, you can either simply display it to a class as you would a Powerpoint, you 

can share it  to allow others to make their own adjustments, or add their own content. These 

options are all controlled from within the Share button at the top right of the Edit screen. 

 

Sway Dashboard 

 Click on the SWAY box at the top left of the screen 

o You are taken back to the Dashboard that you saw when you started Sway. 

All of your Sways are displayed here, along with useful information about how many times they have 

been viewed etc. You can also recover deleted Sways from the Deleted tab. 

If you already have lots of Powerpoints, Word Documents or even PDF files that you would like to 

turn into Sways, click the Start From A Document button, then select the document to use. Sway will 

import the content, images etc (but not the animations from a Powerpoint), and add them to the 

edit area. You can then simply “REMIX” them to add the design, and your Sway is complete. 
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Forms 

Forms are a great way of gathering information from your pupils, or for running fun quizzes. 

Accessing Forms 

Forms can only be access via the App Launcher within an Office 365 app, such as OneDrive or Mail. 

Form or Quiz? 

These are basically the same, with the only difference being that with a quiz, there are correct 

answers, and you can assign points to each question. 

Getting Started 

 From you Forms dashboard, click on New Form 

 Click the title, and change it to your own title, and add a description if you wish. 

 Click the Add Question button 

o You can see the different types of questions that you can add in Forms. 

You will see as you add questions, that you can make each one a “required” answer. This means that 

the pupils cannot skip that question. You also have the option of adding an image or video, which 

the question may be based on, or simply to use as decoration.  

 

Choice – Multiple Choice question, with the option of adding multiple answers. You can also add an 

“other” option, which will then prompt for their answer.  Examples could be: 

“What is the square root of 144?” (single answer) 

“Which of the following politicians are currently members of the Cabinet?” (multiple 

answers) 

“What is your favourite Colour? Red, Green, Brown, Other(Please specify)” 

 

Text – The question requires the pupil to type their answer into a text box. You can make the box 

bigger, thus allowing a longer answer, by clicking the “Long Answer” button. Example could be: 

“In your opinion, who has been the most effective Prime Minister in the past 50 years, and 

why?” 

 

Rating – Pupils are asked to give a rating of something from 1 to anything up to 10. You can also 

choose the symbols used from Stars or Numbers. Example could be: 

“From 1 to 10, how much do you enjoy Broccoli?”  

 

Date – Pupils are required to use a date-picker to specify a date. Example could be: 

“When is Easter this year?” 
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Use the Ellipses (…) to access other types of questions: 

Ranking – Pupils have to put items into an order. In a Form, this has no correct answer, but in a Quiz, 

you set the correct answer.  Example could be: 

“ Which pastimes do you enjoy (favourite at the top, least favourite at the bottom)” – No 

Correct Answer 

“Rank these in order of seniority – Private, Corporal, Lance Corporal” – Correct Answer 

 

Likert – This is a table, where the pupil is required to select various answers that apply to different 

options. Example could be: 

The following ingredients are used in which of the following products 

 Bread Pancake Omelette 

Flour    

Eggs    

Milk    

 

 

Net Promoter Score – this is a typical “How likely are you to recommend us…” type of question, with 

a ranking from 0 to 10, with the options of changing the wording. 

 

Branching 

Click the Ellipses (…) at the top right corner of the screen, and one of the options is Branching. This is 

where the order of the questions is determined by the responses to previous questions. For 

example, the question may be “Do you enjoy taking part in the Choir”. A “yes” answer could then 

lead to the question “What is your favourite thing about it?”, whereas a “No” answer could lead to 

“What can we do to improve your singing experience?” 

 

Set a Theme 

You can adjust how the form looks, and add a background image by clicking the THEME button at 

the top of the screen. 

 

Settings 

The other options under the Ellipses, include the Settings. This is where you can decide things like 

who can complete the form (anyone in the world, or limited to Glow users), whether the pupils 

names are recorded, or can they complete it anonymously (useful for sensitive questions, perhaps 

about bullying, or Human Biology-related questions), plus various options about how the responses 

are dealt with.  
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Displaying the Form / Running the Quiz 

To use the Form or Quiz, you first of all need to get it to the recipients, which will mean sharing it.  

 Click the SHARE button 

o You are shown the various options for how to share the form: 

 

 - Creates a link to the form that you can use on a web page or Blog, for example. 

 - Generates a QR (Quick Response) code that can be scanned with a smartphone, allowing 

the form to be completed on the same device. This can also be added as an image to a webpage or 

blog. 

 - Generates an iframe HTML code, so that the form can be embedded directly into a 

webpage, blog, or even a Sway. 

- Opens up a new email with a link to the form already included, ready to send to your 

recipient. 

 

You also have the options of sharing the Form as a template, or to duplicate it for others to edit it. 

 

Gathering Responses 

Once the form/quiz has been completed, you can go to the Responses tab to view the responses. 

You will see an overview of the responses at the top, followed by the details of each question, how 

people answered it etc. The information is all displayed very clearly, and in different ways, 

depending on the type of question. Each question has a More Details button that will give you the 

individual responses from each participant. You also have an option to open the responses as an 

Excel Spreadsheet, which can be useful for statistical analysis. 
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OneNote 

OneNote is a powerful way to gather information from lots of places and store it in a single, easy to 

access “Notebook”. It can be used by individuals, or by teams of colleagues, or as a teaching tool by 

a teacher with the class.  

Accessing OneNote 

OneNote can only be accessed via the App Launcher from any Office 365 app, such as OneDrive or 

Mail. There currently isn’t a tile available for it on the launchpad. 

Getting Started 

 Click the OneNote app icon from within the App Launcher 

o You are shown your OneNote dashboard. This shows various tabs, including My 

NoteBooks, Shared With me and Class NoteBooks. All notebooks that you have 

access to are displayed here, and the ones you have used recently are shown under 

the Recent tab. 

 Click the My Notebooks tab 

o These are the notebooks that you have created. There will be an empty one called 

“your_name @ Glow Scotland” Click this one to get started. 

 

Basic Structure 

Notebooks consist of Sections, each of which contain Pages. You can add as many sections as you 

like, and each section can have as many pages as you like. The pages can include hyperlinks, so you 

can easily set up a menu structure for larger notebooks. 

The screen has 4 main areas. A Toolbar along the top, the two small columns at the left are the 

sections and pages, and the contents of the selected page are shown in the main work area in the 

middle of the screen. 

Getting Started 

 If there is a section in the far left column (possibly called Quick Notes), right-click on it, and 

choose Rename 

 Rename the section ”Section 1” 

o An “untitled Page” appears in the Pages column.  

 Right-click on that page, and rename it “Page 1” 

 The main area displays the date at the top. Click here to add a title. You can call the page 

whatever you like. 
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The content of the pages can be treated as simple word processing documents, but with a few 

additions.  

 If you click somewhere in the middle of the screen, an empty box appears for you to add 

content to. This box can be resized and moved to any part of the screen, allowing you 

freedom to put content in any place, rather than be limited to lines. Think of them as Text 

Boxes in Word, but for any content.  

 The Insert Tab on the menu allows you to add content of various types, but notice you can 

also add a form that you have created in Forms. Or you can create a new form directly 

within OneNote if you prefer. 

 You can also add “Stickers”, which are graphics to decorate your page with. They are 

categorised, and the top two categories (Bubble Doodles and Doodle Frames) allow you to 

edit the graphic to add text, names etc. 

 Also in the Insert tab, you can add an audio recording, directly within OneNote. This could be 

useful to gather pupils’ ideas on the fly, or if you are working collaboratively with colleagues 

on a project, to get an instant response to something (remember you can use OneNote on a 

smartphone). 

 The Draw tab allows you or the pupils to draw freehand onto the page, using a variety of 

different tools. Again, this could be useful if you are using a smartphone or tablet. 

Adding More Content 

 Click the + PAGE button at the bottom of the Pages column 

o A blank page is added, ready to add more content 

 Click the + SECTION button at the bottom of the Sections column 

o A New Section is created. 

 Any section or page can be viewed simply by clicking it on the appropriate column. 

Rename Your Notebook 

Double-Click on the title in the black bar above the menu. 

Sharing  

OneNote Notebooks can be shared in exactly the same way as every other Glow file. 

 Click on the Share button 

o The sharing options appear. 
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Start a New Notebook 

You may have noticed that there is no option on the dashboard to create a new Notebook. Instead, 

you create your new notebooks from within the notebook you have just been working on. As a 

result, you may want to treat the current Notebook as a “practice area”, and put your proper 

content into a new Notebook. 

 On the bar above the Sections and Pages columns (which contains “Your_name @ Glow 

Scotland”), click the three lines at the left. 

o This will open up the list of Notebooks on the far left. 

 At the bottom of this column, click New Notebook. 

 Name your new Notebook 

o Your new Notebook is created, ready for you to add content to. 
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Teams 

Teams are collaborative spaces where you can work with colleagues or pupils. You can create 

assignments, access OneNote Notebooks, store and access files, schedule meetings and much more. 

Because Teams is so powerful, this section will only contain the basics of setting up a team, and some 

basic usage. You are encouraged to explore it at your leisure. 

Getting Started 

When you open Teams for the first time, you have an option to Create a Team, or Join a Team with a 

Code. We will create a new team. 

 Click the Create a Team button 

o You are asked to decide what type of team you are creating. 

 Click Classes 

 Name your team 

o Remember it is good practice to include the school, year group and subject in your Team 

name, in the same way as you did for groups. 

 If you like, you can add a description of the Team. 

 Add Members  

o Type the names of people, or distribution lists in your contacts, and they can be added 

to the team. You can have more than one member of staff per team, allowing for team-

teaching, or collaboration. 

 Once your members are added, your Team dashboard opens up. 

General Overview 

Down the left hand side of the screen are various icons, and you can see from those what is available to 

you. Click on one of these icons, and the page will show you the relevant options for that icon. 

For example… 

 Click on Meetings, and you will see any meetings that you have been invited to, and you will have 

the option of creating a new meeting. 

 Click on Files, and you will see the contents of your OneDrive, and any files that have been 

shared with you by the team. You also have the option of including other cloud storage, such as 

Dropbox or Google Drive, so you, and the rest of the team (with your permission) can access any 

of your files. 

 Click on Assignments, and you can create assignments or quizzes for your pupils, along with their 

due dates, associated files etc. 

 Click on the Ellipses (…), and you have access to other apps, notably OneNote, where you can use 

any of the OneNote notebooks you have with the team. 

 You also have the option of using Chat with the team, which could be useful for remote 

collaboration, perhaps with other teachers of your subject across Scotland.  

 The Teams icon opens up a page which itself contains various tabs. 

o Conversations – you can see the conversations happening within the team 

o Files – storage area for files used by the team 

o Class Notebook – Create a OneNote Notebook for use by the team 

o Assignments – Create or review any assignments set by you for the team. 

o + - this allows you to add a new tab, with a selection of other apps, such as Forms, PDFs, 

Powerpoint, Word Doc, or a Wiki. 


